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2 About this document

2.1 Legend

The following symbols and formats will be used throughout the document.

Important
It gives you important information about the subject.

Please read carefully!

.:O} Hint

It gives you a hint or provides additional information about a subject.

QN Example

%t‘ It gives you an example of a specific subject.
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3 Key features

The DS-CAM-640c is a high-speed 10 Gigabit-Ethernet camera with the following key data:

Up to 640 FPS @ VGA (640x480) & 8Bpp or 115 FPS @ 2048x1536 & 12Bpp
Real-time data streaming with full resolution

Color camera

Real-time JPEG compression

Adjustable & automatic shutter time

Adjustable & automatic gain

Auto-white balance

PTP Synchronization

Standard C-mount lens mounting

Small form factor

Rugged aluminum housing (high shock and vibration resistance)

The camera supports the high-performance industrial standard “GigE Vision 2.0".

The benefits of the GigE Vision protocol are

High-speed data transfer rates up to 10 GBit/s,

Connectible to every standard GigE Ethernet port, switch with PTP support required if PTP
Synchronization is used.

Cable lengths up to 100m.

DewesoftX® uses OptoStream SDK for communication with cameras that support the GigE Vision
standard.

DS-CAM-640c & 1100m V23-2
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3.1 System Requirements

3.1.1 Basic configuration

1x Gigabit-Ethernet port

High-performance PC (Core i5 CPU or better recommended, 8 GB RAM and high-performance
SSD storage disc)

DewesoftX® 2022.1 or newer

GigE plugin V7.7 or newer

The latest OptoStream SDK

Dewesoft GigE driver (cdv)

3.1.2 Optimal configuration

1x 10 Gigabit-Ethernet port

High-performance PC (Core i7 CPU, 16 GB RAM, and high-performance M.2 SSD storage disc)
Latest DewesoftX®

The latest OptoStream SDK provided with a fresh installation of DewesoftX®

Dewesoft GigE driver (cdv)

DS-CAM-640c & 1100m V23-2 3/42
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4 Technical data
4.1 Specifications

Intel® Core™ i5; 4x 3.4 GHz; 8 threads Intel® Core™ i5; 4x 3.4 GHz; 8 threads
Processor [ (Intel® Core™ i7; 8x 4.5 GHz; 16 threads) (Intel® Core™ i7; 8x 4.5 GHz; 16 threads)
Memory |8 GB (Reccommended 16 GB) 8 GB (Reccommended 16 GB)
Storage [High-performance SSD (M.2 SSD) High-performance SSD (M.2 SSD)
Ethernet port |1x 10Gbit 1x 10Gbit
DewesoftX® 2022.1 or newer DewesoftX® 2022.1 or newer
GigE plugin V7.7 or newer GigE plugin V7.7 or newer
Software |The latest OptoStream SDK The latest OptoStream SDK

Lens mount |C-mount C-mount

M12 /12 pins (SACC-CI-M12FS-8CON-L180-10G) to [M12 /12 pins (SACC-CI-M12FS-8CON-L180-10G) to

Data Connector |RJ45 RJ45
M12 /12 pins (SACC-CI-M12MS-12CON-L180) to M12 /12 pins (SACC-CI-M12MS-12CON-L180) to
Power Connector |L1B2m L1B2m
Synchronisation |SoftSync [2ms], PTP Ready SoftSync [2ms], PTP Ready

Type |Color Monochrome
Image sensor |Sony IMX252 Sony IMX421 Gen3
Sensor type [CMOS CMOS
Resolution |Up to 2048 px x 1536 px Up to 1920 px x 1464 px
200 FPS @ 2048x1536 400 FPS @ 1920x1464
FPS|300 FPS @ 1920x1080 540 FPS @ 1920x1080
(Max interface speed |520 FPS @ 800x600 900 FPS @ 800x600
10Gbit) [640 FPS @ 640x480 1100 FPS @ 640x480
Sensor size |1/1.8" 2/3"
Scan Area|7,06 mm x 529 mm 8,71 mm x 6,59 mm
Pixel size (in pm) 3,45 um (H) x 3,45 pm (V) 45um (H) x 45 um (V)
Dynamic range |71 dB typical 71,5 dB typical
Shutter |Global Shutter Global Shutter
ExposureAuto ExposureAuto
GainAuto with GainAuto with
BrightnessAutoPriority based on BrightnessAutoPriority based on
Auto Functions|BrightnessAuto ROI BrightnessAuto ROI
Picture compression |Baseline JPEG (ISO/IEC 10918-1) Baseline JPEG (ISO/IEC 10918-1)

Power supply|19,2 ...28,8 V DC 19,2..28,8V DC

Power consumption |[approx. 10,0 W @ 24 VDC and 216 fps approx. 1.6 W @ 24 VDC and 411 fps

DS-CAM-640c & 1100m V23-2 4/42
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0°C..+65°C 0°C..+60 °C
Operating Temperature |@ T = Measurement Point @ T = Measurement Point
Storage Temperature|-10 °C ... + 70 °C -10°C..+70°C
Humidity |10 % ... 90 % non-condensing 10 % ... 90 % non-condensing
IP40 (with mounted lens and 10 GigE cable) IP40 (with mounted lens and 10 GigE cable)
IP rating | IP65/67 (with mounted tube and cable) IP65/67 (with mounted tube and cable)
119 x 60 x 60 mm 119 x 60 x 60 mm
Dimensions|4.68 x 2.36 x 2.36 in 468 x 236 x2.36in
Weight [485 g 4859

DS-CAM-640c & 1100m V23-2 5/42
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4.2 DS-CAM-640c & DS-CAM-1100m Dimensions
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Image 1. Technical drawing of DS-CAM-640c & DS-CAM-1100m
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4.3 Scope of supply

4.3.1 DS-CAM-640c & DS-CAM-1100m Scope of supply

Optics|LENS-AZURE-1614MM Azure 1614MM C-MOUNT lens
Cooling |HEAT-SINK-TYPE-A Required for ambient temperatures above 30°C
Signal transfer | CABLE-GigE-M12X/RJ45-5.0m 5m M12X to RJ45 CAT6A signal cable

5m M1212 to L1B2m power cable compatible with SIRIUS,
PS-120W-L1B2f-PHG power supply or
Power transfer | L1IB2m-M1212-5m POWER-SPLITTER-1xL1B2m-5xL1B2f

Packaging|Carrying bag Carrying bag with foam insert for transportation and storing
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Image 2. Scope of supply for DS-CAM-640c & DS-CAM-1100m.
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4.3.2 DS-CAM-640c & DS-CAM-1100m Accessories

Camera IP65 lens cover consisting of Adapter and Tube for
mounting on DS-CAM-640c & 1100m
IP Protection | DS-CAM-IP65-COVER Combined length of 60mm

AC/DC power supply adapter

Connectors: Lemo LIB2f-PHG,

Country wall socket

Power: 120 W 24V @ 5 A)

Fits DS-CAM-640c, DS-CAM-1100m

Power supply | PS-120W-L1B2f-PHG Cable length: 3 m (1.5 m to adapter, 1.5 m from adapter)

Power distribution box

Input connector: L1IB2m

Multi-camera power Output connector: 5x L1B2f
splitter | POWER-SPLITTER-1xL1B2m-5xL1B2f Maximum input current: 15 A

4.4 Camera pinouts

On the backside of the camera, there are two connectors. One for the Power cable and the second one
for the data transfer.

DEWESoft

DATA
POWER LED 1 CONNECTOR
CONNECTOR LED 2

Image 3. Connectors on DS-CAM-640c & DS-CAM-TI00mM
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4.4.1 DATA CONNECTOR PINOUT

1IMX1+
MX1-
MX2+
MX2-
MX4+

MX4-
MX3-
MX3+

O]l PPl HN]|DN

Image 4. IO connector pin-out (M12/12-pin a-coded)

Camera connector: SACC-CI-M12FS-8CON-L180-10G
Camera connector: SACC-CI-M12MS-12CON-L180

T rEER e B e

1|Power Vcc

GND (Power)

INT (LineO)

OUT1 (Line4)

IN2 (Linel)

OUT2 (Lineb)
OUT3 (Line6)
RS232 TxD (Line2)
OUT4 (Line7)
RS232 RxD (Line3)
GND (10)

Power (10)

|||l PN DN

o

J—
pu—)

—_
N

Image 5. IO connector pin-out (M12/12-pin a-coded)
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4.5 Connection examples
Examples below will show typical configurations for DS-CAM-640c & DS-CAM-1100m. Keep in mind that
the synchronization between other devices is done by SoftSync with a precision of 2 ms.

4.5.1 Stand-alone DS-CAM

The most basic of configurations is a single camera or multiple cameras connected to a PC.

-
|

PS-120W-L1B2f-PHG GJG:_

DEWESoft’ F

Image 6. Single-camera connected to PC
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4.5.2 SIRIUS with DS-CAM

A simple SIRIUS-based measurement system coupled with DS-CAM video acquisition

Image 7. A basic system with a camera SIRIUS and PC

4.5.3 SBOX, SIRIUS with DS-CAM

In this configuration, a SIRIUS Data Acquisition Device is used connected to an SBOX. The DS-CAM is
connected to the SBOX over one of its two LAN ports. In such configuration, power can be provided
either from SIRIUS PWR Out, as then the camera is the last device in the daisy chain, or frorm SBOX PWR
Out, if you supply the SIRIUS from a different source.

DEWESoft F—-

Ah DEWESo”

..._u’s -

Image 8. SBOX based system with SIRIUS and DS-CAM
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4.5.4 KRYPTON® connection example

The KRYPTON rugged configuration is not much different from a typical SIRIUS configuration, but in this
case, we recommend also using DS-CAM-IP65-COVER for added protection.

P5-120W-L1B2f-PHG

Image 9. KRYPTON-based system

4.5.5 Multi-camera solution

Image 10. Configuration with multiple cameras over a switched network

DS-CAM-640c & 1100m V23-2 12/42
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4.6 Resolutions / Framerates

Sensor type Sony IMX252 Sony IMX421 Gen3
Active pixels 2048 x 1536 1920 x 1464
Max-Frame rate 200 FPS 400 FPS

LIST OF STANDARD RESOLUTIONS AND FRAMERATES WITH 1Gbit LAN

QXGA 2048 x 1536 138 FPS /
1920 x 1464 200 FPS 150 FPS
Full HD 1920 x 1080 200 FPS 195 FPS
HD ready 1280 x 720 330 FPS 380 FPS
XGA 1024 x 768 415 FPS 490 FPS
SVGA 800 x 600 520 FPS 690 FPS
VGA 640 x 480 640 FPS 1100 FPS
QVGA 320 x 240 1150 FPS 1900 FPS
Hint

~ L4
-—< >: Maximum Frame rate measurements were done @8bit resolution with 85% JPEG compression
= on a 1Gbit LAN connection. Bigger values could be reached with either more JPEG compression
or >1 Gbit Lan.

Important

Results (FPS) should be considered only as approximate MAX values. It depends on the system
performance (CPU, JPEG compression, hard disk). We recommend testing cameras with your
setup at about 0.8*max_FPS and higher to find where corrupted image, frame loss, or buffer
overrun will occur.

DS-CAM-640c & 1100m V23-2 13/42
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5 Installation and start-up

Hint
If you encounter any issues refer to the GigE Camera's Recommended Ethernet Settings in the

DewesoftX online manual. Disabling unneeded options and filters and adjusting Jumbo
packets & Receive Buffer size might solve your issues.

s1a
-~ .

L 4 ~

1II<:)

5.1 DewesoftX® full installer

If you run a fresh full installation of DewesoftX® all the drivers come preinstalled. In this situation, you
can skip to chapter 5.4. Step-by-step procedure for a first start-up.

5.2 DewesoftX® partial installation

If you already have a version of DewesoftX® check if the drivers are installed by running DewesoftX®
and going to Options - Installed extensions. Check if the “GigE" Extension is present and if the version
is 7.6 or more.

If not, update DewesoftX® on Options » Check for updates... or execute the full installer again. When
the installer starts up choose the Modify option and proceed to the next step.

Welcome

Modify, repair, or remove the program.

tup Maintenan ogram. This
of the options p

'@ Mol |:|if'!p'

= M
&

¥ Repair

[ i Reinstall all program features installed by the previous setup.
ol

'i Remaove

@ Remove all installed features.

DEWESoft

< Back Mext = Cancel

DS-CAM-640c & 1100m V23-2 14/42
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When the setup prompts to select features, enable the checkbox for the GigE camera and at this point
also check the state of the OptoStream GEV Filter. Select it for installation if not previously installed.

Select Features

Select the features setup will install.

ct which options to install for Dewesofty 2022, 1.

Jescription

=@ Extensions Installs Dewesoft,
= Cameras

B GigE camera

EEI:
[+

=i
E—:IH Drivers

- OptoStream GEV Filter

T 5
DEWESoft’ o
=l

< Back Mext = Cancel

The last DewesoftX® full installer can be downloaded here:

https://download.dewesoft.com/list/dewesoftx

DS-CAM-640c & 1100m V23-2 15/42
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5.3 Manual installation

5.3.1 Required files
OptoStream SDK for GigE Vision

e (o to https://download.dewesoft.com/list/plugins/ and download the GigE package
e Itincludes the latest OptoStream SDK and Dewesoft driver for GigE Vision.

e When manually installing OptoStream SDK, Note that you must be an administrator, not just a
user with admin rights!

DewesoftX®

e Available from https:/download.dewesoft.com/list/dewesoftx
i, Hint

~ 4
:O: You need to be logged into the Dewesoft website to download the latest development versions
T  of DewesoftX®.

5.3.2 Adding GigE Addon

To enable the camera in DewesoftX® copy the file “GigeCamera.cdv” into the Dewesoft Addons folder,
usually located in “C\DewesoftX\Bin64\Addons64\GigeCam”.

5.3.3 Installing GigE Addon
Run the "Dewesoft DCOM Registration” to register the plugin.

| = | Bing4 @ Dewesoft DCOM and addens registration {ver. 1.7) *
Home Share View Addons
« v 4 > ThisPC » Local Disk (C:) » DewesoftX > BinB4 » [] Dewesoft DCOM server
B
B e [ Regstr |
» g Quick access %] canarcmibd.dil 3DModels4. ve OK ~
y ADMA,_Ethernet.dll Ok
& OneDrive candbcbd.dll ARINC_MIL 155364, dll OK
Cgostd.dil ASAM_MDF464.exp OK
) - ASAM_ODS64.exp OK
v E This PC d3dx3_33_64.dlI Attitudelndicators4. ve OK
. DCOMReq.exe AutoExporta4.dil OK
» 8 3D Objects _ BarcodeScannera4.dll OK
5 [ Desktop £ DEWEsoft.exe BrakeNoises4.dll OK
D DEWESoft.map BrakeTests4.mth OK
» [E D t ' *BWF.exp OK
peuments ¥ [ Chanter 1A Al Qi

Image 13. Example of DCOM Addons Registration

OK, cameras can be used, close the OptoStreamViewer and start DewesoftX®

DS-CAM-640c & 1100m V23-2 16/42
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5.4 Step-by-step procedure for a first start-up

5.4.1 Install OptoMotive_OptoStreamSDK

Restart the PC after the installation is complete. After the reboot, be sure that “OptoStream GEV Filter

Driver’ is installed under Windows 11 Settings » Network & internet - Advanced network settings -
“Used Ethernet card” - Properties.

ey Hint

,O. Note that “Filter Driver” filters out all packets that are not GigE on the hardware level, so the
= camera will work much faster than without the filter.

" [ DELL Latitude Status

m
4

@ DELL Latitude Properties

General Networking  Sharing
connection Connect using:
IPv4 Connectivity: Mo Internet access '? Intel{R) Ethemst Connection (4) 1215-LM
IPva Connectivity: Mo network access .
Configure...
Media State: Enabled
This connection uses the following items:

Duration: 03:24:23

O I?Clierrt for Microsoft Networks
Speed: 1.0 Gbps F . ) !

O ]? File and Printer Sharing for Microsoft Networks
!OptoStream GEV Fitter Driver

[ 2 BthercatDAQ Filter

[ 52 Qo5 Packet Scheduler
N [ % FortiClient NDIS 6.3 Packet Fiter Driver

Activity ] 2 Baumer Packet Fitter Driver
Sent —— Lg ——  Received
a‘“ﬁ-jﬁ.f Install... Uninstall Properties
Bytes: 10,283,738 | 115,272,512,414 Description
MNDISE GigE Vision Fiter Driver
¥ Properties ® Disable Diagnose
Close

Image 14. “Used Ethernet card”

Important

oK

Cancel

Image 15. Installed OptoStreamViewer GEV Filter Driver

If you intend to use this Local Area Network card solely for video acquisition, we recommend also
disabling all items except OptoStream GEV Filter Driver & Internet protocol IPv4 (TCP/IPv4)

DS-CAM-640c & 1100m V23-2
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5.4.2 Connect and power up

Connect the camera to the PC via Ethernet cable and power it up.

Important
DS-CAM-640c & DS-CAM-1100m require a power supply with 24VDC * 20% capable of providing
at least 0,5A /12W or more.

5.4.3 Assigning IP address to camera

The DS-CAM-640c & DS-CAM-1100m support DHCP, so connecting them to a managed network should
be a straightforward procedure. Open the OptoStreamViewer to check if all of the connected cameras
are recognized and working by selecting the Control tab and running the Find devices command.

When cameras are recognized you can change their IP with Control - Set Ip To Device

Control
.| 4@ Find Devices
5 Set Ip To Device

E Connect Device

]
@

©) set Device Ip Address ? X

Ip Configuration
4@ Disconnect Device
_ V| LLA
Firmware Update
v | DHCP

Previ
review v Permanent Ip Address

Ip Address  [10_.2_ .171.41_
Subnet Mask |255.255.0__.0__
Gateway 0o_.0_.0_.0

| Ok Cancel

Image 16. Set Ip To Device procedure.
or connect for adjustment and preview with Control » Connect device.

File VWiew NOGIGIGEIN Displays Help
- . 1
(2& (Pg | @ Find Devices : .
'ﬁ ﬁ - Device Properties n
5@ Set Ip To Device
Devi
E:TES ®" Connect Device o Start O Stop
Mode

Q_ Disconnect Device Parameters Device Info Reqisters

Firmware Update

Visibility | Beginner ~ '@F‘.Eﬁesh
Preview
Praparty Valus +
S (L
Ariinilalb | Cantiniiaiie

Image 17. Connecting devices to OptoStreamViewer.
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i, Hint
':O:' Although the DS-CAM-640c & DS-CAM-1100m come configured in DHCP mode, at the first
T  startup we recommend defining a fixed IP for each camera separately before connecting them
to a switch or a network. If you are having issues with camera recognition use the IP Config Tool
on the below link for discovery and configuration.

https://drive.google.com/file/d/lyd FkvtvzKPETU mMuXw382toHSYIQKI6_ZN iew?usp=sharing

Important
Avoid using OptoStreamViewer and DewesoftX® in parallel.

5.4.4 Enable video

To enable the video channel go to Video, click the Video tab, and switch fromm Unused to Used.

@O B & W = % + —

Stare Save Save as Staring Analog in Video Math More. .. Remove
Camera options
Store options Frame rate
always fast e 100 w

D |C Used

Channel name Camera name Camera status Frame rate mode | Setup

0 Camera 0 Baumer - ¥LXT-31C.1.JP Frame rate: 100,00 fps Free running Setup

1

Camera 1 Baumer - VLXT-28M.1.JP Frame rate: 100,00 fps Free running Setup

Image 18. DewesoftX® Channel setup -» add Video

DS-CAM-640c & 1100m V23-2 19/42


https://drive.google.com/file/d/1ydFkvtvzKP6TUmuXw382toHSYIQkI6_Z/view?usp=sharing

DS-CAM-640c & DS-CAM-1100m A DEWESOft®

TECHNI

CAL REFERENCE MANUAL

5.4.5 Preview and settings

Enter the channel by pressing the setup button of the desired camera for picture preview and settings.

Camera settings

EERTELE % Resolution ADC resclution
] mexis w2
Frame rate
100,00 frames/s (Max: 6,554E04)

Preview - 32,0 fps/ 12,6 MB/s

Shutter
10000,00 us

Gain

| | 1,00
Automatic shutter Continuous v
Automatic gain Off v
Automatic white balance  Off -
8 IPEG quality 85 %

18 optimize for switched network Packet size: 1500 kb
Packet delay:0 ticks

Advanced setup...

Image 19. DewesoftX® video channel setup

Camera name defines the “channel” name that will be stored and used for measurement
Color of the camera “channel” data displayed in measure & analysis can be changed
Resolution drop-down menu offers some predefined standard sizes or a Custom option where
Width and height in pixels can be defined.

ADC resolution changes the Bits per pixel sensor acquisition quality.

Frame rate defines the number of pictures acquired per second.

The Shutter bar determines the light exposure duration (brightness).

If the light is too dark, use the Gain bar to increase brightness by software.

White balance is used for color source correction.

The JPEG quality is inverse to the compression. 80% means good quality, low compression.

To improve the performance if using the camera on an Ethernet switch, use “Optimize for
switched network”

Use the “Advanced Setup’, if you want to change specific parameters of the camera, such as the
custom resolution and AQOI, area of interest, for instance.

Hint

DS-CAM-640c & 1100m V23-2 20/42



DS-CAM-640c & DS-CAM-1100m ®
TECHNICAL REFERENCE MANUAL A DEWESOft

If you change the frame rate, after typing the value, the input field gets a yellow color; confirm the value
by pressing the Enter key.

Important
Changes in Frame rate will take a global effect. All cameras connected to the system will run at
set FPS if they are able and their shutter time permits it.
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6 Troubleshooting guide

6.1 No data in DewesoftX® camera setup

Due to a delayed startup of the camera, loss of connection, or improper detection DewesoftX can return

a “No data” message instead of a video feed. In this case, navigate to Options » Settings » Devices - <
and refresh the devices list. This will re-establish the connection to all devices.

6.2 The GigE checkbox in Settings is missing

Go to My Computer and click System properties » Advanced system settings » Advanced tab -
Environment Variables » System variables » select Path » Edit.

Make the following changes:

e %OPTOSTREAM_SDK_PATH%\bin
e %GENICAM_ROOT_V2_4_ARCH%\bin\Windows
e %GENICAM_ROOT_V2_4_ARCH%\bin\Windows \GenApi\Generic

Save and reset Windows. Path correctness can be checked by GetEnvironmentVariable('PATH');

6.3 No picture shown, “No frames received” error

If you receive the error “NO FRAMES RECEIVED”, check:

Try decreasing the Shutter value
Check under Settings if the DewesoftUSB device is set to Clock/Trigger or Automatic
(Standalone)

e Disable Trigger in hardware setup and check if it's working in free-run mode (This could
potentially be a cable problem. Swap in new cables and try again)

6.4 Camera not found (not in OptoStreamViewer, not in DewesoftX®)

e Check if the status LED on the camera is green, booting takes ABOUT 1 MINUTE!

e Ifusing a GigE-Switch with PoE ports, ensure output power is sufficient, check status LED during
operation
e Check Windows Firewall settings

6.5 Camera “not found”

(not found in DewesoftX®; yellow mark in OptoStreamViewer)

Not able to use the cameras. Please wait a little bit (until IP is assigned). If that does not help, ensure the
computer's network IP is set to automatic, as the camera supports DHCP.
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Further troubleshooting, most probably the computer and the camera are not in the same subnet.

o OptoStreamViewer (Warning: OptoMeotive Filter Driver not loaded.)

File View Control Displays Help

B pgBb aaalfl OB

Devices H X

Model - MALC IP Address
M Velociraptor  00:60:35:33:88:80 169.254.1354

Image 20. IP address problem

Important
You should avoid using OptoStreamViewer and DewesoftX® in parallel. If the cameras are not
found in DewesoftX® close it and start OptoStreamViewer for troubleshooting.

6.6 Change the IP address of the camera with OptoStreamViewer
Control
‘il Find Devices

B Set Ip To Device
E Connect Device

W B
Devices
Model

©) set Device Ip Address ? X

Ip Configuration
4@ Disconnect Device
v | LLA

Firmware Update
V| DHCP

Previ
review v | Permanent Ip Address

Ip Address |10_.2_.171.41_

Gateway  |0_.0_.0_.0

|
Subnet Mask | 255,255.0_.0__ |
|
|

| Ok | | Cancel

Image 21. Change the IP address of the camera

If you manually change the IP address, please use the same subnet as the computer, for example,
PC:169.254.135.5, Subnet 255.255.255.0
Camera: 169.254.135.4, Subnet 255.255.255.0

The IP is ok, if the cameras are found with a red mark (see lllustration above), close OptoStreamViewer
and start DewesoftX®.
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6.7 Change the IP address of the camera with Baimer IpConfig tool

A) Proceed to Baumer web page > Product Overview > Industrial cameras / image processing >
Software > Baumer Camera Explorer and download the latest Software packages for your OS.

B) Install the software with customized settings as Baumer Filter Driver is not required if you don't
intend to use Camera Explorer.

Customized Setup
Select the way you want features to be installed, @

Click on the icons in the tree below to change the way features will be installed.
Description

Install the Baumer Filter
Driver

= vI Baumer Camera Explorer v3.3.0
: ¥ - | Windows 10 Universal CRT
¥_~| Baumer USB Driver

Baumer Filter Driver

This feature requires OKE on
your hard drive.

Image 22. Camera Explorer custom installation options
Important
If you decide to install the full package don't forget to disable Baumer Filter Driver it in LAN card
settings, if you encounter any issues with video acquisition in DewesoftX.

C) Run IpConfig-Tool from Start menu and proceed with the following steps.
Rescan the network for all cameras

Select the desired camera you want to edit

Enable Presistant IP

Define IP address and Subnet mask

Press the Set button to save the settings

Clisk the Rescan button to refresh and confirm the change

Power cycle the camera!

=] Baumer GigE IPConfig — a X

No o~ N~

Application  Force-IP

Rescan o

Available cameras Available interfaces
Type Serial number IP Address Subnet Mask
VLXT-06M.IJP 700005971489 e 10.2.170.69 255.255.0.0

10.2171.40  255.255.0.0

Config options Camera information
L4 BoHe B Pmisbentu,e IP address: 10.2.171.41
Persistent IP Subnet mask: 255.255.0.0
MAC address: 00:06:be:10:1e:3e
IP address: 10 J2 171 |41
User-defined name:  DS-CAM-1600m_DEV
Subnet mask: 255 255 0 0
: : . Interface: 10.2.171.40
Set
LLA: enabled
s s DHCP: enabled
D-CAM-1500m_DEV Set Persistent |P: enabled
i Baumer Gose

Image 23. Persistent |P definition procedure
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6.8 GIigE Vision client does not start, error message when starting

Troubleshoot this using the following steps: Check if the operating system of your computer is 32bit or

64bit.
Copy the 64-bit dlls (otherwise take the ones from the 32bit directories) from
C\Program Files\OptoMotive\OptoStreamSDK\bin\Win64 and
C\Program Files\OptoMotive\OptoStreamSDK\GenlCam_v2_4\bin\Win64_x64 to
\Windows\system32 (respectively \Windows\SysWOW64)

Then start the OptoStreamViewer from C\Program Files\OptoMotive\OptoStreamSDK\bin\Win64

6.9 Cameras not working in DewesoftX®

If you followed the step-by-step installation procedure, but still the camera is not working in
DewesoftX®, you can try to copy the used DLLs manually:

Example of Copying the 32-bit DLLs from
C\Program Files\OptoMotive\OptoStreamSDKbin\Win32
and
C\Program Files\OptoMotive\OptoStreamSDK\GenlCam_v2_4\bin\Win32_i86
to
Dewesoft's Addons folder.
Then restart DewesoftX®.
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6.10 Manual driver Uninstall/Install

a. Open Network Connections Dialog

| L& Network Connections

1T E’ » Control Panel » All Control Panel ltems » MNetwork Connections

Qrganize v
"'-. Ethernet 10 "'-. Ethernet 11 "'-. Ethernet &
. Network cable unplugged . Network cable unplugged . Network cable unplugged

K G Intel(R) Gigabit CT Desktop Adapt.. $E W Intel(R) Ethernet Controller X550 24 3¢ @27 TNITIOP 10GBase-T/NBASE-T Eth...

"'-. Ethernet 9 "'-. Viware Network Adapter VMnet1 "'-. Viware Network Adapter VMnet®
&,ﬁ Network cable unplugged &,ﬁ &,ﬁ-

Enabled Enabled
X 7 Killer E2200 Gigabit Ethernet Cont... &7 YMware Virtual Ethernet Adapter ... W Vhware Virtual Ethernet Adapter ...

Image 24. Network Connections

b. Right-click and properties to one of the Network Adapters

I? THNS710P 10GBase-T/NBASE-T Ethemet Adapter H2 gg
u

This connection uses the following items:

[ B Client for Microsoft Netwaorks ~
[ "3 vMware Bridge Protocol

O ’:? File and Printer Sharing for Microsoft Networks

w2 OptoStream GEV Fitter Driver

T Npcap Packet Driver (NPCAP)

] 52 qoS Packet Scheduler

. Intemet Protocol Version 4 (TCP/IPv4) v
£ >

Ingtall... Uninstall Properties
Description

MDISE GigE Vision Fitter Driver

Cloze Cancel

Image 25. Network Adapter properties

- ] X
v [J] Search Network Connections 0
F- m @
Ethernet &
Network

@ Intel(R) Ethernet Controller X550 23

t @ Ethernet 6 Properties » fonnection Change settings of this connectic
Networking  Sharing '"'-h' Ethernet 6
i * _ Network cable unplugged
Connect using: 9 @7 TNOTIOP 10GBase-T/NBASE-T Eth...

VMware Network Adapter ViMnetd
* _ Enabled
T VMware Virtual Ethernet Adapter ...
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c. Mark the Optostream GEV Filter Driver and Click Uninstall and Yes

able t| @ Ethernet 6 Properties < tonnection Change settings of this connection

0 Networking  Sharing -~ Ethernet & v~ Ethernet 8

able y L..q}f Metwork cable unplugged L,‘R« Metwork

jabit{  Connect using: x @2 TNGTI0P 10GBase-T/NBASE-T Eth... =4 Intel(R} Ethernet Coi
? TNS710F 10GBase-T/NBASE-T Ethemet Adapter £2 L". VMware Network Adapter VMnetd

able U o=  Enabled

0 Gigg Configu Ll 8T \huears Vicboal Etharnst Adantar

This connection uses the following tems:

O I?'Z:Ii'arltfer Microsoft Networks

O ’:]?VMware Bridge Protocol Uninstalling a feature removes it from all network

O ’1]? File and Printer Sharing for Microsoft Networks o conne_ctions._Are you sure you want to uninstall Optostream
!OptoStream GEV Filter Driver GEV Filter Driver?

U Npcap Packet Driver (NPCAP)

[ Q05 Packet Scheduler

. Intemet Protocal Version 4 (TCP/IPv4) UE Hg
< T
Install... Unirstall Properties
Description
NDISE GigE Vision Fitter Driver
Cloze Cancel
Image 26. Uninstall GEV Filter driver
¢. Now after the Uninstall Gevfilter Driver is no longer in the list
1 @ Ethernet & Properties = e

Metworking  Sharing

{  Connect using:

I TWI710P 10GBase-T/NBASE-T Ethemet Adapter #2

3 Configure...

This connection uses the fallowing items:

O !Client for Microsoft Networks ~
] % VMware Bridge Protocal

O ’:]? File and Printer Sharing for Microsoft Networks

I Npcap Packet Driver (NPCAP)

[] 53Qo5 Packet Scheduler

4 Intemet Protocol Version 4 (TCP/1Pw4)

[ 4 Microsoft Network Adapter Muttiplexor Protocol W
£ >

Install... Uninstall Properties
Description

Allows your computer to access resources on a Microsoft
network.

Close Cancel

Image 27. Empty Network Adapter properties
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d. After the existing Driver is uninstalled, we install a new GevFilterDriver by clicking on Install, Select
Service, and Add.

@ Ethernet 6 Properties by %onnectiun Change setti

Metwarking |Seing | Select Metwork Feature Type .
ble ur
Connect using: | Click the type of network feature you want to install: el
I? TNS710P 10GBase-T/NB '?Client letwork
!Senrice frtual
4 Protocol e
This connection uses the followin

1 B Client for Microsoft Nety ~ Description

] ¥ VMware Bridge Protoc  Services provide additional features such as file and
] % File and Prirter Sharing| ~ printer sharing.

4 Npcap Packet Driver (I

[] %005 Packet Scheduler

2 Intemet Protocol Versiol

[ 5 Microsoft Network Adag Add. Cancel
< |
T
Install... Uninstall Properties
Description

Allows your computer to access resources on a Microsoft
network.

Cloze Cancel

Image 28. Select feature Type

e. Select Have Disk.

let @ Ethernet & Properties * tonnection Change settings of this connection I:

| Select Network Feature Type * - Ethernet 8
ble unplugged ’%’! Metwork
0

Networking  Sharing
ley

5 ing: T/ TEth... G Intel(R X350 £3
it{  Connect using | e e s o el featimesyont werd 0 stel GBasze-T/MBASE-T Eth == Intel(R) Ethernet Controller X!
58 TNS710F 10GBase-T/NB B Clert uetwork Adapter VMnetd
ed
99 . Protocal Select Metwork Service ? X
This connection uses the fallowin

O !Client for Microsoft Ned Description [ Clic_k the h!etwo_rk Senr\ge that you wart to insta_ll. then click OK. f you have
0 ’:]?VMware Bridge Protocd Servicss provide additional fetures such !’ an installation disk for this feature, click Have Disk

[] *3File and Printer Sharing|  printer sharing.
"]? Npcap Packet Driver (i

[ #Pq0S Packet Scheduler

2 Intemet Protocal Versiol Manufacturer Network Service: C
O . Microsoft Network Adag Add.. Microsoft Micfcsoﬂ MAC Bridge
< | | | Nmap Project [=] Microsoft NDIS Capture
. - ™r Optomotive d o o Q Microsoft Windows Filtering Platform
EE S FEZEIEE PEF WFP Capture Driver | | [=] NativeWiFi Fiter
Description [=INnG Parket Srhed lar ¥
Allows your computer to access resources on a Microsoft This driver is digitally signed. "
network. Have Disk...

Tell me why driver signing is important

0K Cancel
Close Cancel

Image 29. Driver path selection Have Disk
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f. Select Browse and choose Path to a new GevFilterDrivera and click Open

B Ethernets Properties x Lonnection Change settings of this connection
Networking  Sharing Select Metwork Feature Type * ‘h' Ethernet 8
lable unplugged = MNetwork
Connect using: T T e e el 0GBase-T/MBASE-T Eth... ﬁg Intel(R) Ethernet Controller X531
[ TNS710P 10GBase-T/NB ‘ etwork Adapter VMnetd
| Colecd Blod, e © ? X
This conned | |ocate File *
@t to install, then click OK. Fyou have
Loak in: | FilterDriver_x64 v| (<} 3 = D g
X
l MName Date modified Type
OptoStrearmGEVFilter.inf 28.10.2020. 15:37 Setug p disk, and then oK
Quick access pelected below.
Cancel
Desktop
Allows yg X n_
netwaorkc. Libraries
S ~ | I Browse...
ThlsPC oK Cancel
£
MNetwork
File name: OptoStreamGEVFitter inf - | Open
Files of type: Setup Information (*.inf) ~ Cancel
Image 30. Driver location file select
g. In the Install from Disk Dialog Click OK
1 @ Ethernet 6 Properties e #onnection Change settings of this connection Z: bl
Networking | Sharing Select Network Feature Type X ‘h' Ethernet 8
u lable unplugged § Network

Connect using:
I? TNS710P 10GBase-T/NB

This connection uses the followi

O !Client for Microsoft Nety
[ %8 VMware Bridge Protacg
[] % File and Printer Sharing
I Npcap Packet Driver (N
[J 5205 Packet Scheduler
. Intemet Protocol Versiol

Click the type of network feature you want to install:

0GBase-T/NBASE-T Eth...

| etwork Adapter Viinetd

T Intel(R) Ethernet Controller X350 #3

Description

Services provide additional features such
printer sharing.

[ s Microsoft Network Aday Add...
<
Install... Uninstall Properties
Description
Allows your computer to access resources on a Microsoft
network.
Close Cancel

Select Network Service

$ Click the Network Service that you want to install, then click OK. i you have
: Sk et : =t

? X

for thio foot Alinl: 1
Install From Disk *
H Insert the manufacturer’s installation disk, and then oK
- - make sure that the comect drive is selected below.

Cancel

Copy manufacturer’s files from:
ChUsers\TestPChDesktop'FilterDriver_x64 b Browse. .
QK Cancel

Image 31. Installation file confirmation
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h. Then to SelectNetwork Service Click OK

let] @ Ethernet 6 Properties 4 %onnactinn Change settings of this connection Z: * [
Netwerking  Sharing Select Network Feature Type x Ethernet 8

ley ble unplugged § * _ Network
Jit{ Connect using: iz T e e e e e 0GBase-T/NBASE-T Eth... =4 Intel(R) Ethernet Controller X330 #3

& TNS710P 10GBase-T/NB B Clert |_|Ijtwork Adapter VMnetd
ey
198 .. Protocol Select Metwork Service ? X

This connection uses the followir
O !C]ient for Microsoft Neﬂ{ Description ¢h Click the Network Service that you want to install, then click OK. F you have |
1 " an i llatinn disk for this featie click Have Disk

O ’?VMWEF& Bridge Protoca Services provide addtional features suchy - o

[ " File and Printer Sharing Brirter sharing. Select Network Service ? X

B Npcap Packet Driver (i ) )

O ")?003 Packet Scheduler !5 Click the Network Service that you want to install, then click OK

2. Intemet Protocol Versiol War -2

[0 4 Microsoft Network Adag Add... m

< ‘ || Nm

T opt :
Install... Uninstall Properties PER Network Service:

Description OptoStream GEV Filter Driver

Allows your computer to access resources on a Microsoft |:£|

netwol

This driver has an Authenticodetm) signature.
Close Cancel B Tell me why driver signing is important

Cancel

Image 32. Network Service selection

i. That list would have a new Optostream GEV Filter driver

f [E] Ethernet & Properties * }0”
Networking  Sharing !
d .
{  Connect using: F ]
@ TNS710P 10GBase-T/NBASE-T Ethemet Adapter #2 l
d 4
| Configure...
This connection uses the following items:
(1 EClient for Microsoft Networks [

[ B8 VMware Bridge Protocol

] 8 File and Printer Sharing for Microsaft Networks
9 OptoStream GEV Fiter Driver

3 Npcap Packet Driver (NPCAF)

[ %905 Packet Scheduler

& Intemet Protocol Version 4 (TCP/1Pvd) W
£ >

Install... Uninstall Properties
Description

NDISE GigE Vision Fiter Driver

Close Cancel

Image 33. Installation confirmation

This completes the manual installation of the GEV Filter Driver

DS-CAM-640c & 1100m V23-2 30/42



DS-CAM-640c & DS-CAM-1100m

TECHNICAL REFERENCE MANUAL A DEWESOft®

6.11 Performance improvements

(e.g. in case of frames lost or buffer overrun)
A loss of a few frames during a measurement is normal, due to collisions on the Ethernet network.

Here are some useful hints to improve the performance:

e Do not operate the camera in a fully-loaded network (e.g. office computers). Just use a direct
connection or one switch (with no additional participants).
e Disable all anti-virus, firewall, indexing, and synchronization programs running in the
background.
e Verify that the PC has a Gigabit-Ethernet network card, not only T00Mbit/s.
o Check thisin Device Manager tools
e Verify that the LAN cable used between the camera and the PC is at least CAT5 quality. For longer
cable lengths CAT6 cable should be used for optimal performance.
For this camera, the best quality can be achieved by using a powerful CPU.
Try to decrease the JPEG compression (e.g. from 80 down to 50%)
Use the Windows resource monitor (can be found in Task manager) to check for bottlenecks.
o Check CPU and RAM
e For optimal performance, we recommend enabling “Jumbo” frames on your PC network card.
“Jumbo” frames are Ethernet packets larger than 1500 bytes. This way less CPU time is spent for
data reception, therefore, increasing performance and minimizing data loss.

ntel(R

thernet Connection (4) 1219-LM Properties >

General Advanced Drver Detals Events Power Management

The following properties are available for this network adapter. Click
the property that you want to change on the left and then select its
value on the right.

Property: Value:

Adaptive Inter-Frame Spacing 5014 Bytes e
Enable PME

Energy Hficient Ethemet

Flow Control

Gigabit Master Slave Mode
Intemupt Moderation

Intemupt Moderation Rate

|Pv4 Checksum Cffload

Jumbo Packet

Large Send Offload V2 (IPv4)
Large Send Offload V2 (IPvE)
Legacy Switch Compatibilty Mode
Link Speed Battery Saver

Locally Administered Address

oK Cancel

Image 34. Jumbo packet settings
Windows 11 Settings - Network & internet - Advanced network settings - “Used Ethernet

card” » Properties » Configure » Advanced » Jumbo Packet - Set to highest value (e.g. 9kB
MTU)
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Windows 10 Control panel > network and internet » view network status and tasks (network
and sharing center) > change adapter settings - right-mouse-click on LAN connection -
Properties » Configure > Advanced » Jumbo Frame - set to highest value (e.g. 9kB MTU))

e Also, an overloaded DewesoftX® setup (many displays, €.g. high-resolution FFT instruments) will
take system power. Try at first only with camera video instruments.

e Press <Ctrl>+<Shift>+<P> in DewesoftX® Measure mode. On the right side, the performance
monitor will appear. Watch the Cam video buffer. It should stay stable at low values.

‘\ — Q DewesoftX 2022.1 (RC-220124) . Mem left: 638IME # CPU: 45 % 5 a=50hz d=42hz _ O X
e Measure I i i

Analyze Setup files Ch. setup Measure @ Edit Options

0||l$¢+lll

Store Pause Stop Freeze Design Widgets  Displays Recorder Custom

@ Video
Controls L @ @ @ CPU 1 &0%
Columns 2 @ @ @ CPU2 0%
CPU 3 453%
Transparency OFF @
CPU 4 45%,
CPUS 75%
Status Preview el =
Frame rate 43,8 CPU7 50%
Buffer used  20% CPU B 20%
Scaling  Proportional w
Physical 5%
Free: £,383/5,751 ME
ci 4%
200 y
——— Free: 129.966/242.412 ME
—
— G 455
— Free: 123.468/242,.412 ME
XY cursor — SR
= ~ = DAQ 0%
=
Rotation Diag proc, speed: 3,45 MS/sec
Fixed - CAN bud 0%
Angle Used: 0 MB
1]
Cam 1 0%
Video rate: 43,8 fps
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7 Warranty information

Notice
The information contained in this document is subject to change without notice.

Note:

Dewesoft d.o.o. shall not be liable for any errors contained in this document. Dewesoft MAKES NO
WARRANTIES OF ANY KIND WITH REGARD TO THIS DOCUMENT, WHETHER EXPRESS OR IMPLIED.
DEWESOFT SPECIFICALLY DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. Dewesoft shall not be liable for any direct, indirect, special, incidental, or
consequential damages, whether based on contract, tort, or any other legal theory, in connection with
the furnishing of this document or the use of the information in this document.

The copy of the specific warranty terms applicable to your Dewesoft product and replacement parts can
be obtained from your local sales and service office. To find a local dealer for your country, please visit
h : W m rt/distri rs.

7.1 Calibration

Every instrument needs to be calibrated at regular intervals. The standard norm across nearly every
industry is annual calibration. Before your Dewesoft data acquisition system is delivered, it is calibrated.
Detailed calibration reports for your Dewesoft system can be requested. We retain them for at least one
year, after system delivery.

7.2 Support

Dewesoft has a team of people ready to assist you if you have any questions or any technical difficulties
regarding the system. For any support please contact your local distributor first or Dewesoft directly.

Dewesoft d.o.o.
Gabrsko 11a
1420 Trbovlje Slovenia

Europe Tel.: +386 356 25 300
Web: http://mww.dewesoft.com
The telephone hotline is available Monday to Friday from 07:00 to 16:00 CET (GMT +1:00)

7.3 Service/repair

The team of Dewesoft also performs any kinds of repairs to your system to assure a safe and proper
operation in the future. For information regarding service and repairs please contact your local

distributor first or Dewesoft directly on https://dewesoft.com/support/rma-service.

7.4 Restricted Rights

Use Slovenian law for duplication or disclosure. Dewesoft d.o.o. Gabrsko 11a, 1420 Trbovlje, Slovenia /
Europe.

7.5 Printing History
Check chapter 9. Documentation Version for History and change log.

DS-CAM-640c & 1100m V23-2 33/42


https://dewesoft.com/support/distributors
http://www.dewesoft.com
https://dewesoft.com/support/rma-service

DS-CAM-640c & DS-CAM-1100m ®
TECHNICAL REFERENCE MANUAL A DEWESOft

7.6 Copyright

Copyright © 2015-2019 Dewesoft d.o.o. This document contains information which is protected by
copyright. All rights are reserved. Reproduction, adaptation, or translation without prior written
permission is prohibited, except as allowed under the copyright laws. All trademarks and registered
trademarks are acknowledged to be the property of their owners.

7.7 Trademarks

We take pride in our products and we take care that all key products and technologies are registered as
trademarks all over the world. The Dewesoft name is a registered trademark. Product families (KRYPTON,
SIRIUS, DSI, DS-NET) and technologies (DualCoreADC, SuperCounter, GrandView) are registered
trademarks as well. When used as the logo or as part of any graphic material, the registered trademark
sign is used as a part of the logo. When used in text representing the company, product or technology
name, the ® sign is not used. The Dewesoft triangle logo is a registered trademark but the ® sign is not
used in the visual representation of the triangle logo.
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8 Safety instructions

Your safety is our primary concern! Please be safe!

8.1 Safety symbols in the manual

Warning
Calls attention to a procedure, practice, or condition that could cause the body injury or death

Ql/_  Caution
. Calls attention to a procedure, practice, or condition that could possibly cause damage to
equipment or permanent loss of data.

8.2 General Safety Instructions

. Warning

The following general safety precautions must be observed during all phases of operation, service, and
repair of this product. Failure to comply with these precautions or with specific warnings elsewhere in
this manual violates safety standards of design, manufacture, and intended use of the product. Dewesoft
d.o.o0. assumes no liability for the customer’s failure to comply with these requirements.

All accessories shown in this document are available as an option and will not be shipped as standard
parts.

8.2.1 Environmental Considerations

Information about the environmental impact of the product.

8.2.2 Product End-of-Life Handling

Observe the following guidelines when recycling a Dewesoft system:

8.2.3 System and Components Recycling

Production of these components required the extraction and use of natural resources. The substances
contained in the system could be harmful to your health and to the environment if the system is
improperly handled at its end of life! Please recycle this product in an appropriate way to avoid
unnecessary pollution of the environment and to keep natural resources.

This symbol indicates that this system complies with the European Union's requirements
according to Directive 2002/96/EC on waste electrical and electronic equipment (WEEE).
Please find further information about recycling on the Dewesoft website www.dewesoft.com

I Restriction of Hazardous Substances
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This product has been classified as Monitoring and Control equipment and is outside the scope of the
2002/95/EC RoHS Directive. However, we take care of our environment and the product is lead-free.

8.2.4 General safety and hazard warnings for all Dewesoft systems

Safety of the operator and the unit depend on following these rules.

Use this system under the terms of the specifications only to avoid any possible danger.

Read your manual before operating the system.

Observe local laws when using the instrument.

DO NOT touch internal wiring!

DO NOT use higher supply voltage than specified!

Use only original plugs and cables for harnessing.

You may not connect higher voltages than rated to any connectors.

The power cable and connector serve as Power-Breaker. The cable must not exceed 3 meters, the
disconnect function must be possible without tools.

Maintenance must be executed by qualified staff only.

During the use of the system, it might be possible to access other parts of a more comprehensive
system. Please read and follow the safety instructions provided in the manuals of all other
components regarding warning and security advice for using the system.

With this product, only use the power cable delivered or defined for the host country.

DO NOT connect or disconnect sensors, probes or test leads, as these parts are connected to a
voltage supply unit.

Ground the equipment: For Safety Class 1 equipment (equipment having a protective earth
terminal), a non-interruptible safety earth ground must be provided from the mains power
source to the product input wiring terminals.

Please note the characteristics and indicators on the system to avoid fire or electric shocks. Before
connecting the system, please read the corresponding specifications in the product manual
carefully.

The inputs must not, unless otherwise noted (CATx identification), be connected to the main
circuit of category I, lll and IV.

The power cord separates the system from the power supply. Do not block the power cord, since
it has to be accessible for the users.

DO NOT use the system if equipment covers or shields are removed.

If you assume the system is damaged, get it examined by authorized personnel only.

Adverse environmental conditions are Moisture or high humidity Dust, flammable gases, fumes
or dissolver Thunderstorm or thunderstorm conditions (except assembly PNA) Electrostatic fields,
etc.

The measurement category can be adjusted depending on module configuration.

Any other use than described above may damage your system and is attended with dangers like
short-circuiting, fire or electric shocks.

The whole system must not be changed, rebuilt or opened.

DO NOT operate damaged equipment: Whenever it is possible that the safety protection features
built into this product have been impaired, either through physical damage, excessive moisture,
or any other reason, REMOVE POWER and do not use the product until the safe operation can be
verified by service-trained personnel. If necessary, return the product to Dewesoft sales and
service office for service and repair to ensure that safety features are maintained.

If you assume a more riskless use is not provided anymore, the system has to be rendered
inoperative and should be protected against inadvertent operation. It is assumed that a more
riskless operation is not possible anymore if the system is damaged obviously or causes strange
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noises. the system does not work anymore. The system has been exposed to long storage in
adverse environments. the system has been exposed to heavy shipment strain.

e \Warranty void if damages caused by disregarding this manual. For consequential damages, NO
liability will be assumed!

e Warranty void if damage to property or persons caused by improper use or disregarding the
safety instructions.

e Unauthorized changing or rebuilding the system is prohibited due to safety and permission
reasons (CE).

e Be careful with voltages >25 VAC or >35 VDC! These voltages are already high enough in order to
get a perilous electric shock by touching the wiring.

e The product heats during operation. Make sure there is adequate ventilation. Ventilation slots
must not be covered!

e Only fuses of the specified type and nominal current may be used. The use of patched fuses is
prohibited.

Prevent using metal bare wires! Risk of short circuit and fire hazard!

DO NOT use the system before, during or shortly after a thunderstorm (risk of lightning and high
energy over-voltage). An advanced range of application under certain conditions is allowed with
therefore designed products only. For details please refer to the specifications.

e Make sure that your hands, shoes, clothes, the floor, the system or measuring leads, integrated
circuits and so on, are dry.

e DO NOT use the system in rooms with flammable gases, fumes or dust or in adverse
environmental conditions.

e Avoid operation in the immediate vicinity of high magnetic or electromagnetic fields,
transmitting antennas or high-frequency generators, for exact values please refer to enclosed
specifications.

e Use measurement leads or measurement accessories aligned with the specification of the
system only. Fire hazard in case of overload!

e Do not switch on the system after transporting it from a cold into a warm room and vice versa.
The thereby created condensation may damage your system. Acclimatise the system unpowered
to room temperature.

e Do not disassemble the system! There is a high risk of getting a perilous electric shock. Capacitors
still might be charged, even if the system has been removed from the power supply.

e The electrical installations and equipment in industrial facilities must be observed by the security
regulations and insurance institutions.

e The use of the measuring system in schools and other training facilities must be observed by
skilled personnel.

The measuring systems are not designed for use in humans and animals.
Please contact a professional if you have doubts about the method of operation, safety or the
connection of the system.

e Please be careful with the product. Shocks, hits and dropping it from already- lower level may
damage your system.

e Please also consider the detailed technical reference manual as well as the security advice of the
connected systems.

e This product has left the factory in safety-related flawlessness and in proper condition. In order to
maintain this condition and guarantee safety use, the user has to consider the security advice
and warnings in this manual.

EN 61326-3-1:2008
IEC 61326-1 applies to this part of IEC 61326 but is limited to systems and equipment for industrial
applications intended to perform safety functions as defined in IEC 61508 with SIL 1-3.
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The electromagnetic environments encompassed by this product family standard are industrial, both
indoor and outdoor, as described for industrial locations in IEC 61000-6-2 or defined in 3.7 of IEC 61326-1.

Equipment and systems intended for use in other electromagnetic environments, for example, in the

process industry or in environments with potentially explosive atmospheres, are excluded from the
scope of this product family standard, IEC 61326-3-1.

Devices and systems according to IEC 61508 or |EC 61511 which are considered as “operationally
well-tried”, are excluded from the scope of IEC 61326-3-1.

Fire-alarm and safety-alarm systems, intended for the protection of buildings, are excluded from the
scope of IEC 61326-3-1.
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9 Documentation Version

V22-0 1.03.2022 Draft
V22-1 14.3.2022 Initial release
V22-2 552022 Minor changes to pictures, data table correction, SoftSinc

value update, IpConfigTool instructions.

V23-1 17.02.2023 Preview and settings chapter update with longer
descriptions

V23-2 2023-03-01 Troubleshooting manual driver install
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11 NOTES

A table for data entry when you are setting up larger systems.

10

n

12
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